
Overview
Welcome to Corel PRESENTS a feature-rich presentation program.

Corel PRESENTS provides you with an easy to use tool for creating presentations quickly and effectively. From 
bulleted text, charts, and handout notes to completely animated sequences, Corel PRESENTS is designed for 
maximum impact.
Corel PRESENTS is the answer to all your presentation needs.



Overview
Get to know the basic concepts of Corel PRESENTS as you make your own presentations by following the steps in
this tutorial. The main window provides you with the tools and commands you need to create your own 
customized presentations.
Often, the best way to learn how something works is by using it. Since Corel PRESENTS is a brand new product, 
you'll want to work through this tutorial. It won't make you a Corel PRESENTS expert, but it will get you started. 
Its lessons in addition to being fun
will help you produce your first attractive and useful presentation. Completing this tutorial will also give you a 

quick overview of Corel PRESENTS, and hands-on practice using it.
For detailed information about any Corel PRESENTS feature, see the online Help.
All the sample files you need to create your presentation are located in the TUTORIAL subfolder of your Corel 
PRESENTS folder.
Before you begin the tutorial, you should be familar with Microsoft Windows the operating system upon which 
Corel PRESENTS runs. You should know how to open and close Windows applications, and how to use a mouse.
What's in store?

Getting started
Meet the Wizard!
Creating a new presentation on start up
Starting a new presentation
Setting up the page
Saving your presentation
Printing your presentation
Exiting Corel PRESENTS



Meet the Wizard!
If you need a presentation in a hurry, use the Corel PRESENTS new presentation Wizard! Using the new 
presentation Wizard is the fastest and easiest way to make a presentation. In this tutorial, you'll meet some of 
the other Wizards that will assist you in creating your presentations.





Getting started
To start Corel PRESENTS

Click the Corel PRESENTS program in the Corel6 folder on the Programs menu.





Creating a new presentation on start up
To create a new presentation

Launch Corel PRESENTS.
The Start up screen options dialog box opens.
This dialog box displays five choices:    Presentation Wizard, Template, Start a blank presentation, Open an 
existing file, and Open the last presentation used.

If you...
Click the Presentation Wizard 

 button,
The New Presentation Wizard appears to guide you through the process of starting a new presentation using 
samples.

Click the Template 

 button,
The Template Library opens so that you can choose a template for your presentation.

Click the Start a blank presentation 

 button,
A blank presentation page opens to which you can add pages and build a presentation from scratch.

For this tutorial, click the Start a blank presentation button.
Note
If you enable the check box at the bottom of the Start up screen dialog box, this screen does not display each 
time you launch Corel PRESENTS.





Starting a new presentation
Once you've launched Corel PRESENTS, you may want to start a new presentation without the Start up screen 
options dialog box.
To start a new presentation

Click 

.
The New Presentation dialog box opens.
The New Presentation dialog box gives you three choices:    Presentation Wizard, Template, and Start a blank 
presentation.

If you...
Click the Presentation Wizard 

 button,
The New Presentation Wizard appears which guides you through the process of starting a new presentation 
using built-in samples.

Click the Template 
 button,

The Template Library opens from which you choose a template for your presentation.
Click the Start a blank presentation 

 button,
A blank presentation page opens to which you can add pages and build a presentation from scratch.

For this tutorial, click the Start a blank presentation button.





Exiting a dialog box
To exit a dialog box without choosing an action

Click Cancel.



Exiting a Wizard
To exit a Wizard without choosing an action

Click Cancel.



Set the page size
To set the page size for all pages in the presentation
1. Click File, Page Setup.

The Page Setup dialog box appears.
2. Click the Size/Margin tab if that page isn't already displayed.
3. Click Slide View, Background View in the Current View section to enable the option.
4. Click the Landscape button in the Page size section to enable the option.
5. Click the Paper type list box and click Screen.

The horizontal and vertical number boxes automatically change their values to represent the screen size. If 
you choose a Custom page type, you can enter specific values in the horizontal and vertical number boxes. If 
you choose a paper type that's larger than Screen, the slide may not display all objects during playback.

6. Click Apply.
The dialog box remains open.

Tip
To apply the changes and close the dialog box, click OK.





Set the page margins
To set the page margins for all pages in the presentation
1. Click File, Page Setup.

The Page Setup dialog box appears.
2. Click the Size/Margin tab if that page isn't already displayed.
3. In the Page margins section, type .75 in the Top number box to change the value.
4. Type .75 in the Bottom number box to change the value.

Leave the default values for the left and right margin settings as 1.00 inch.
5. Click Apply.

The dialog box remains open.
Tip
To apply the changes and close the dialog box, click OK.





Create a header/footer
To create a header/footer for all pages in the presentation
1. Click File, Page Setup.

The Page Setup dialog box appears.
2. Click the Header/Footer tab.

The Header/Footer page displays.
3. In the View section, click the Slides button to enable the option.
4. Click the Header list box and click ;;Slide 1.

Slide 1 appears in the top right corner of the slide.
5. Click the Custom Footer button to open the Customize Header/Footer dialog box.

The cursor automatically appears in the Left section of the footer.

6. Click  to insert a page number.
7. Press the TAB key to move to the Center section of the footer.

8. Click  to open the Date and Time dialog box.
9. Click one of the date and time formats.

You can also click the Customize button to create a custom date and time format for the footer.
10. Click OK to apply the changes and close the Date and Time dialog box.
11. Click OK to apply the changes and close the Customize Header/Footer dialog box.
12. Click OK to apply the changes and close the Header/Footer page.









Saving your presentation
To save your presentation for the first time
1. Click File, Save.

The Save as dialog box appears. This dialog box appears only on the initial save.
2. Click the Save in list box and open the Tutorial folder in which to store your presentation file.
3. Type a name for your presentation in the File name text box.

Corel PRESENTS automatically assigns .CPR as the file extension for a PRESENTS file in the Save as type list 
box.

4. Click Save.
Your presentation is saved with its new filename.

Note
To save an existing presentation with a different filename (and/or in a different location), click File, Save as. To 
save further changes to an existing presentation, click File, Save.





Closing the current presentation
To close the current presentation file and remain in Corel PRESENTS

Click File, Close.
If you have changed your presentation, a message box appears prompting you to save those changes.



Exiting Corel PRESENTS
To exit Corel PRESENTS

Click File, Exit.
If you have changed your presentation, a message box appears prompting you to save those changes.



Printing your presentation
You can print all or part of your presentation at any time.
To print your presentation
1. Click File, Print.

The Print dialog box opens.
2. Click a Print Range button to enable an option.

The All button is the default selection.
3. Type a number in the Number of copies number box if you want more than one copy.
4. Click the Print Style list box to see the available print styles.

Corel PRESENTS is the default style.
5. Click the Print box and click Slides.

You can also print Speaker Notes, Handouts, or Outline text view.
6. Click the Include Backgrounds check box to enable the option.

Disable the option if you want to print your presentation without its background(s).
7. Click OK.
Note
For more information about printing, see Corel PRESENTS online help.





Summary
Congratulations! You're on your way with Corel PRESENTS. You know how to start the program, save your work, 
print a presentation, and exit the application. In Lesson 2, you're going to create your first presentation.



Overview
A meaningful presentation is a series of organized thoughts conveyed through words and images. It's important 
that your audience get the full impact of what you're trying to say.
What's in store?

Choosing a template, layout, and background
Inserting slides
Working in Outline view
Working with text in Slide view
Applying slide transitions
Previewing your presentation
Creating audience handouts



Opening an existing presentation
If you have closed your presentation from Lesson 1, re-open it to continue the tutorial.
To open an existing presentation
1. Click File, Open.

The Open dialog box appears.
2. Click the Look in list box and scroll until you find the Tutorial folder.
3. Double-click this folder to open it.
4. Click the presentation file you named in Lesson 1 to highlight it.

Its name appears in the File name text box.
5. Click Corel PRESENTS Files (*.CPR) in the Files of type list box if it's not already selected.
6. Click Open.





Overview
The template, layout, and background are the building blocks of your presentation.
A template is a layout combined with a preset background. A layout displays pre-defined areas or place-holders 
where text, graphics, charts, and animations are placed. Corel PRESENTS offers several interesting template 
styles on which you can base your presentation.
A background consists of the underlying elements that cover each page in your presentation, such as color. You 
can create your own background or choose one from the Corel PRESENTS background library.
For this tutorial, create your own template by combining a layout and a background.



Choosing a layout
To choose a layout for the first slide
1. Click View, Layout Library.

The Libraries dialog box appears.
2. Click the Layout tab if it's not already displayed.

The Layout page opens.
3. Click the Preset library button to enable the option.
4. Scroll through the slide thumbnails and click the Title slide layout.
5. Click OK.

This action applies your choice and closes the dialog box.
Note
To leave the dialog box open so you can use another tab, click Apply Now.





Choosing a background
To choose a background for the first slide
1. Click View, Background Library.

The Libraries dialog box appears.
2. Click the Background tab if it's not already displayed.

The Background page opens.
3. Click the Select a background from list box and click group15.cpb.

The Load from button gives you access to backgrounds from other Corel PRESENTS' files.
4. Scroll through the slide thumbnails and click the blue background with the yellow ribbon on the left.
5. Click OK.

This applies your choice and closes the dialog box.
Tip
The background color favored by most people is blue!





Navigating through a presentation
There are several ways to move from one slide to another in Corel PRESENTS. Choose any method from those 
described below.

Click the numbered slide tab on the bottom of the presentation window.
In Outline view, double-click the numbered slide icon.
In Slide Sorter view, double-click the numbered slide thumbnail.
Click Edit, Go To Slide.
Click a tab scrolling button at the bottom left of the presentation window.



Inserting slides
Slide 1 in your presentation is the title slide. Now, add three more slides. Corel PRESENTS lets you insert slides, 
choose another slide layout, and choose a different slide background all by using the Insert Slides Wizard.

To insert slides
1. Click Insert, Slide.

The Insert Slides Wizard appears.
2. Type 3 in the Number of Slides number box.
3. Check that the After Current button is enabled. If not, click it to enable the option.
4. Click Next.

The Insert Slides - Select A Layout page appears.
5. Click the Preset library button to enable the option.
6. Scroll through the slide thumbnails and click the slide layout that has placeholders for a title and bullets.
7. Click Finish.
Note
The new slides automatically take the default background. That's the last background you selected in the 
Libraries dialog box.





Overview
This is where you fine tune your presentation's message. Outline view displays only the text portion of your 
slides. Work in Outline view when you want to concentrate on your presentation's textual content.



Switching to Outline view
To switch to Outline view

Click View, Outline.
Outline view is displayed.

Each page in your presentation is represented by a number and an icon in the left margin of Outline view.



Adding text in Outline view
Take a moment to become familiar with Outline view. The screen resembles a blank piece of paper and there are 
some additional buttons specific to this view.
To add text in Outline view
1. Position the cursor beside Slide 1, if it's not already there.
2. Type the following text:

Presenting Corel PRESENTS!
3. Press SHIFT and ENTER at the same time.

This moves the cursor to a new line.
4. Type The Presentation you've been waiting for!
Note
All slides have Presenting Corel PRESENTS! as the title. You can retype it each time or copy and paste it.



Zooming in on text
To zoom in on text
1. Click the Zoom flyout in the toolbox.

2. Click Zoom in ( ) to magnify a portion of the screen.



Zooming out
To zoom out
1. Click the Zoom flyout in the toolbox.

2. Click Zoom out ( ).
Note
The Zoom out tool zooms out by a factor of two each time you click, or it returns you to the view you were at 
before the last zoom in.



Adding a new bullet
To add a new bullet after the title

Press CTRL and ENTER at the same time.



Adding consecutive bullets
To add consecutive bullets

Press ENTER after each bullet.



Adding text to the remaining slides
Type the following text on Slides 2 and 3
Slide 2
Easy to use
Hard to forget
Corel PRESENTS
Your best bet yet!
Slide 3
A layout is a blueprint
A background is a stage
Create text in Outline view
Your words fly off the page!



Overview
Text levels help to standardize the appearance of your text throughout a presentation. You can customize text 
levels so that they suit your purpose.
With Corel PRESENTS, you can promote and demote text levels, rearrange text on a slide, and move text from 
slide to slide.
Practice working with text levels using the promote, demote, up, and down arrow buttons on the Outline view 
toolbox.
Note
The cursor becomes an i-beam while on the Outline view page.



Demoting text
To demote a text level
1. Select the bullets on Slide 2 to highlight them.

2. Click the Demote paragraph button ( ).
The bullets move one level to the right.



Promoting text
To promote a text level
1. Reselect the bullets on Slide 2 to highlight them.

2. Click the Promote paragraph button ( ).
The bullets move one level to the left.

You can experiment moving text around on an individual slide or from one slide to another. Just reverse your 
actions to return the text back to its original spot.



Moving text from slide to slide
To move text from slide to slide
1. Select the bullets on Slide 3 to highlight them.

2. Click the Down arrow button ( ).
The bullets move to Slide 4.

3. Reselect the bullets on Slide 4 to highlight them.

4. Click the Up arrow button ( ).
The bullets return to Slide 3.



Overview
Use the tools in Outline view to apply various attributes to your text. Corel PRESENTS provides you with default 
text attributes that you can modify at any time.
Add variety to your text by adding bold and italic styles and varying the font type. Keep the number of font types
to a minimum consistent-looking text is eye-catching but too many styles can distract your audience.



Applying font styles
To apply a font style
1. Go to Slide 1 and select the title Presenting Corel PRESENTS!.

2. Click  to make the title text bold.
3. Repeat steps 1 and 2 for each title on Slides 2 and 3.



Changing font sizes
To change a font size
1. Go to Slide 1 and select the title Presenting Corel PRESENTS!.
2. Click the font size list box to display font sizes.
3. Scroll down and click 32.

The title's text increases in size.
4. Repeat steps 1 to 3 for each title on Slides 2 and 3.



Changing font types
To change a font type
1. Go to Slide 1 and select the title Presenting Corel PRESENTS!.
2. Click the font list box to display font types.
3. Scroll up and click Arial.

The Arial font compliments Times New Roman, the font used for the bullets.
4. Repeat steps 1 to 3 for each title on Slides 2 and 3.



Overview
If you're working with several slides and a variety of text formats, use draft mode to hide text attributes. Draft 
text is displayed in one font type allowing you to concentrate on creating the presentation's content. Preview 
mode displays text complete with style attributes.



Working in draft mode
To work in draft mode

Click the Show formatting button (

) to depress it.
The text is displayed without style attributes.



Working in preview mode
To return to preview mode

Click the Show formatting button (
) again to return it to its normal state.

The text is redisplayed with its style attributes.



Switching to Slide view
You can type text directly onto your presentation page.
To switch to Slide view

Click View, Slide.
You're now in Slide view.



Overview
Artistic text is typed directly on screen just click and type! Artistic text characters can be stretched, scaled, and
reshaped. This feature comes in handy for creating headlines and text with special effects.



Adding artistic text
To add artistic text
1. Go to Slide 4.

2. Click the Artistic text tool ( ) in the toolbox.
3. Position the cursor on the upper left of the slide and type the title:

Presenting Corel PRESENTS!
Once you have typed your text, you can apply the same text attributes as you did in Outline view.



Overview
Paragraph text is typed in a frame that you create. This is also called a marquee. When a paragraph text frame is
resized, the point size of the text remains the same.



Adding paragraph text
To add paragraph text
1. Go to Slide 4.

2. Click the Paragraph text tool ( ) in the toolbox.
3. Position the cursor underneath the title and draw a frame.
4. Type the following text:

Choose a catchy bullet style
Sweep a slide from left to right
Print the audience a handout
Give your show some bite!

5. Select and resize the paragraph text frame.



Positioning text in Slide view
You may discover that after you've added text directly onto Slide 4, it isn't positioned as precisely as the text on 
the other slides. Corel PRESENTS allows you to position text exactly where you want it.
To position text in Slide view

1. Click the Pick tool ( ) in the toolbox.
2. Click anywhere on the title to select it.

You'll see selection handles around the text.
3. Click the Pick tool ( ) again.

4. Click the paragraph text frame.
You'll see similar selection handles around the frame.

5. Click  in the text toolbar.
The bullets move to the exact center of the text frame.

Note
If the text requires additional positioning, select and drag it to a new spot on the slide.



Changing the color of text
When you see your slides in Slide view against a blue background, you'll notice that black text doesn't show up 
very well. It's important that the person seated in the last row be able to read your message.
To change the color of text
1. Move to Slide 1.
2. Click the pick tool ( ) and click the slide's title to select it.

3. Click one of the bright yellows from the on-screen color palette with the left mouse button.
The text has taken the yellow fill.

4. Click a dark gray or black color from the on-screen color palette with the right mouse button.
The text's outline has taken that fill color.

5. Repeat these steps for all the text on all your slides.



Overview
Bullets are symbols used in a list to separate items in a series. A bullet can emphasize a point and make a 
document easier to read and understand.



Applying bullet styles
To apply bullet styles
1. Go to Slide 2.
2. Select the bullets.
3. Click Format, Bullet Style.

The Select Bullet dialog box opens.
4. Click the Font list box and click Wingdings.
5. Click the Happy Face ( ) bullet.

6. Click the Enable Bullet check box to enable the option.
7. Click OK.

Repeat these steps for Slides 3 and 4. Choose a different bullet style for each slide, if you wish.





Overview
Don't worry if you've made some typing errors so far they're easy to correct in Corel PRESENTS. You can spell 
check your presentation in Slide view, Outline view, Handout view, and Speaker Notes view.



Spell checking your presentation
To spell check your presentation
1. Position the cursor at the starting point of text.
2. Click Tools, Proof Reading, Spelling.

The Spell Check dialog box appears and a sentence-by-sentence spelling check begins. When the Proof Reader
finds a word that is not in the dictionary, it highlights the word in the Sentence box. Suggested replacements 
are shown in the Change To box.



Correcting misspelled words
To correct a misspelled word
Pick an applicable step:

Type the correct spelling in the Sentence display box and click Change. Click Change All to correct all 
occurrences of the word.

Select one of the alternative spellings from the Change To list box and click Change. If there are no 
alternatives for the misspelled word, No Alternatives appears in the Change To list box.

Click Change All to correct all occurrences of the word.
When all words have been checked, a message box appears. Click OK to return to your presentation.



Overview
Transitions are special effects you assign to an individual slide or to objects on that slide to make your screen 
show visually interesting. You can have opening and closing transition effects, such as a wipe, where the page is 
gradually revealed, or choose random transition and let Corel PRESENTS surprise you.



Applying an opening transition
To apply an opening transition to a slide
1. Click the Slide 1 tab at the bottom of the screen.

You're now on Slide 1.
2. Move the cursor to an open area of the slide.
3. Click the right mouse button, then click Properties.

The Slide Properties dialog box opens.
4. Click the Transitions tab if this page isn't displayed.
5. In the Opening Transitions section, click the Transition list box.
6. Scroll up and click Wipe Across.
7. Click the Direction list box and click the right arrow.
8. Type 2 in the Duration number box.
9. Click the down arrow in the Steps number box and scroll to 20.
You've given Slide 1 an opening transition called Wipe Across that takes 20 steps and two seconds to complete.



Applying a closing transition
To apply a closing transition to Slide 1
1. Click the Slide 1 tab at the bottom of the screen.

You're now on Slide 1.
2. Move the cursor to an open area of the slide.
3. Click the right mouse button, then click Properties.

The Slide Properties dialog box opens.
4. Click the Transitions tab if this page isn't displayed.
5. In the Closing Transitions section, click the Transition list box.
6. Scroll up and click Fade.
7 Type 2 in the Duration number box.
8 Type 20 in the Steps number box.
9 Click OK.
You've given Slide 1 a closing transition called Fade that takes two seconds and 20 steps to disappear.



Overview
You can preview or playback your presentation at any time. You can preview the entire presentation or playback 
one slide at a time.



Previewing a single slide
To preview a single slide
1. Go to Slide 1.

This is a good choice since you've just applied a transition to this slide.

2. Click .
The current slide plays.



Previewing the entire screen show
To preview the entire screen show

Click File, Run Presentation.
The entire presentation plays. This is called run-time mode.



Returning to edit mode
To return to edit mode

Press the ESC key.
Note
The default length of time for a slide to play during a screen show is 10 seconds.



Overview
Handouts are information about your presentation that you give to your audience. Corel PRESENTS provides you 
with a handout layout library from which you can choose several interesting handout styles.
Tip
Distribute handouts before you begin the presentation so that the audience can make their own notes, if they 
wish.



Choosing a handout layout
To choose a handout layout
1. Click View, Handout.

You're in Handout view.
2. Click View, Layout Library.

The Libraries dialog box opens.
3. Click the Layout tab if that page isn't already displayed.
4. Click the Preset Library button to enable the option.
5. Scroll through the slide thumbnails and click a handout layout of your choice.

Use this handout layout to create audience handouts for this tutorial.
6. Click OK to apply your choice and close the dialog box.



Creating audience handouts
To create an audience handout
1. Double-click a handout text box near the slide thumbnail on the handout layout.

You have activated the Paragraph text tool ( ) and can type your notes.
2. Type the following handout notes:

"There are many handout layouts to choose from in the preset library."
3. Fill in the remaining handout notes with your own text.
Note
Choose one of these methods to move from one handout to another:

Click the handout tab at the bottom of the screen.
Click Edit, Go To, Handout.



Summary
Your presentation is really taking shape! You've learned how to assemble a presentation by combining a layout 
and background to create your own custom template. Working in Outline view is a snap, and adding artistic text 
is as easy as click and type. You've also made your presentation visually interesting by applying a slide 
transition. In Lesson 3, you're going to add a chart.



Overview
If your presentation contains figures or financial data, a chart is an effective communication tool. Charts show 
your data in a clear and visual way that is easy to understand. Your audience will appreciate it.
What's in store?

Inserting a chart slide
Working in chart view
Working with chart data
Changing and formatting chart types
Adding graphics
Applying transition effects to objects
Defining slide properties
Creating speaker notes



Inserting a chart slide
It's time to reinforce some skills you've already mastered in Lesson 2 by using the Insert Slides Wizard to add a 
new slide with a chart placeholder.
To insert a new slide with a chart
1. Click Insert, Slide.

The Insert Slides Wizard appears.
2. Type 1 in the Number of Slides number box.
3. Check that the After Current button is enabled. If not, click it to enable the option.
4. Click Next.

The Insert Slides - Select A Layout page appears.
5. Click the Preset library button to enable the option.
6. Scroll through the slide thumbnails and click the slide layout that has text and chart placeholders.
7. Click Finish.
Note
The new slide automatically takes the default background. That's the last background you selected in the 
Libraries dialog box.





Working in Chart view
To activate Chart view
1. Go to Slide 5.
2. Double-click the chart placeholder.

The Chart Type dialog box appears.
Corel PRESENTS offers a wide variety of chart types from the familiar line and bar charts to the more 
specialized types like polar and radar. Later, you'll learn how to change chart types, but for now let's go with 
the default Vertical Bar chart.

3. Click OK.
You're in Chart view.

Take a moment to become familiar with Chart view. As in Outline view, there are new tools and menu items 
specific to Chart view.



Working with chart data
A chart represents data in a visual way. For this tutorial, you'll use sample data for creating a chart.
To load data
1. Click Chart, Data.

The datasheet opens.
2. Select cells A1 to E5.

The cells are highlighted.
3. Click OK.
You return to Chart view. You perform the same steps when you load real data from a datasheet that you create. 
See the Corel PRESENTS online help for information about importing data from other applications.



Changing chart types
As promised earlier, it's time to change chart types.
To change chart types
1. Click Chart, Chart Type.

The Chart Type dialog box opens. The default chart type is vertical bar.
2. Scroll down the Chart Type list box and click 3D Scatter.

The different flavors of this chart type are displayed as thumbnails in the preview window.
3. Click XYZ Scatter with Labels.
4. Click OK.
Tip
When you click OK, you apply the currently highlighted chart type and close the dialog box.



Formatting a chart
To change format properties
1. Click Chart, Format.

The Format Properties dialog box appears.
2. Click the Axis tab to enable the page if it's not already visible.
3. Click From the Top in the Preset Viewing Angles list box.
4. Click OK.

The chart is displayed from a whole new angle.



Changing the legend style
To change the legend style
1. Click Chart, Legend.

The Legend dialog box appears.
2. Click the Text below marker button to enable the option.

The text was originally to the right of the legend markers.
3. Click OK.



Removing the legend
To remove the legend
1. Click Chart, Legend.

The Legend dialog box appears.
2. Disable the Display Legend check box.
3. Click OK.

The Legend disappears.



Adding text to the chart slide
Add text to the chart slide using Outline view. Don't forget you can type text directly onto a slide in Slide view. 
Feel free to apply style attributes to the text as you did on the previous slides. See Lesson 2 for some pointers.
To add text to Slide 5
1. Click outside the chart to exit Chart view.
2. Click View, Outline.

Outline view displays.
3. Position the cursor beside Slide 5.
4. Type the following title:

Presenting Corel PRESENTS!
5. Type the following bullets:

How's this for a chart?
It's data plus art!

Tip
To add a new bullet after the title, press CTRL and ENTER at the same time. Press ENTER to add consecutive 
bullets.



Overview
It takes more than words to make an impressive and interesting presentation. You can create your own images or
import graphics from other applications.



Adding graphics
To add graphics to your presentation
1. Go to Slide 1.

2. Click the Rectangle tool ( ) in the toolbox.
The drawing tools flyout opens.

3. Click the Polygon tool ( ).
The cursor becomes a cross hair.

4. Pick an open spot on the slide.
5. Click and drag the mouse and let go.

Right now the object you've drawn looks like a pentagon.
Draw as many polygons as you want and position them anywhere on the slide. Stay tuned for editing and adding
color.





Overview
When you're working with the drawing tools, it's convenient to detach the section of the toolbox you're working 
with so that you have easy access to it. You can open it and position it on the presentation screen.



Detaching the toolbox
To detach a section of the toolbox
1. Click the Pick tool ( ).
2. Click the Rectangle tool ( ) in the toolbox.

The drawing tools flyout opens.
3. Click the outer edge of the flyout, and while holding down the mouse button, drag the flyout away from the 

toolbox.
4. Position the flyout anywhere on the presentation page.
5. Release the mouse button.





Editing graphics
Transform these graphics into stars.

To edit a polygon to make a star
1. Click the Pick tool ( ) and click a polygon to select it.

The polygon is surrounded by black selection handles.

2. Click the Shape tool ( ) and notice two things:
The cursor becomes the node edit tool.
The black selection handles are replaced with small, hollow squares called nodes.

3. Click a node with the Shape tool.
4. Drag the node inward, outward, and rotate it.
5. Release the mouse button when you have a star like the ones in the picture below.
Experiment with the Shape tool and give each star on Slide 1 a different, special look.



Applying color to graphics
If you have any favorite colors, now's the time to show them off. There are several different ways to add color to 
an object in Corel PRESENTS. The steps below describe one way see the online help for other methods.

To apply a different color to a graphic
1. Click the Pick tool ( ) and click a star to select it.
2. Click the up arrow ( ) to the right of the on-screen color palette to expand it.

3. Click a color, any color!
4. Select another polygon. This time, click a color using the right mouse button.

This action applies a different outline color to the graphic.
5. Continue to color in your polgons and outline them, if you wish.
Note
To apply the same color to several objects, click an object to select it, then hold down the SHIFT key and click the
remaining objects.



Overview
When you're editing and manipulating objects in your presentation to get the effect that's just right, you often 
have to make several tries before you're satisfied. You can always undo an action if you don't like the results.



Undoing actions
To undo an action

Click Edit, Undo.
The action is reversed.

Note
There are multiple levels of Undo in Corel PRESENTS, meaning you can reverse several actions one at a time.



Overview
You applied opening and closing transition effects to a slide in Lesson 2. Now, you're going to apply transition 
effects to an object on a slide.



Applying an opening transition to an object
To apply an opening transition to an object
1. Move to Slide 1.
2. Click the Pick tool ( ) and select a star.

3. Click the right mouse button on the star, then click Properties.
The Object Properties dialog box appears.

4. Click the Transitions tab if this page isn't already displayed.
5. In the Opening Transition section, click the Transition list box.
6. Scroll up and click Pond Ripple.
7. Type 4 in the Duration number box.
8. Leave the default number of 30 steps in the Steps number box.
9. Click Apply Now to apply the change and leave the dialog box on-screen.
Note
This type of transition does not require a specific direction.



Applying a closing transition to an object
To apply a closing transition to an object on Slide 1
1. In the Closing Transition section, click the Transition list box.
2. Scroll up and click Iris or Circle out.
3. Type 4 in the Duration number box.
4. Leave the default number of 30 steps in the Steps number box.
5. Enable the Preview option to see the transition effect.
6. Click OK to apply the changes and close the dialog box.
Note
This type of transition does not require a specific direction.



Assigning a path to an object
A path is the route the object takes to move from one point to another on the slide during the screen show.
To assign a path to an object
1. Click the Pick tool ( ) and select a star.
2. Click the right mouse button, then click Properties.

The Object Properties dialog box appears.
3. Click the Path tab.

The Path page appears.
4. Scroll up the list box and click Diagonal Top-Right Bottom-Left.
5. Click the Preview box to enable the option.

You see the object follow the selected path in the Preview window.
OR

6. Click OK to apply the path and close the dialog box.



Overview
You can define or change the properties of any slide at any time. These settings affect the individual slide.



Naming a slide
To name a slide
1. Move the cursor to an open area of any slide.
2. Click the right mouse button, then click Properties.

The Slide Properties dialog box appears.
3. Click the Slide tab.

The Slide page appears.
4. Type a name for the slide in the Name text box.
5. Click Apply Now to apply the change.
6. Click OK if you wish to apply the change and exit the Slide Properties dialog box.





Showing slide margins
To show slide margins
1. Click Tools, Options.

The Options dialog box appears.
2. Click Show margins to clear the check mark.
3. Click OK.





Showing the header/footer
To show the header/footer
1. Move the cursor to an open area of any slide.
2. Click the right mouse button, then click Properties.

The Slide Properties dialog box appears.
3. Click the Slide tab.

The Slide page appears.
4. Click the Show Header check box to enable the option.
5. Click the Show Footer check box to enable the option.
6. Click Apply Now to apply the change.

OR
7. Click OK if you wish to apply the change and exit the Slide Properties dialog box.





Hiding a slide
To hide a slide
1. Move the cursor to an open area of any slide.
2. Click the right mouse button, then click Properties.

The Slide Properties dialog box appears.
3. Click the Slide tab.

The Slide page appears.
4. Click the Hide Slide check box to enable the option.
5. Click Apply Now to apply the change.

OR
6. Click OK if you wish to apply the change and exit the Slide Properties dialog box.
Note
Only enable this option if you want to conceal a slide within your presentation that contains confidential 
information that you don't want the audience to see.





Overview
Speaker notes are pages associated with each slide in a presentation on which notes can be added as an aid to 
the presenter. If you're suddenly at a loss for words, glance down at your speaker notes. As with audience 
handouts, Corel PRESENTS provides you with a speaker note layout library from which you can choose a specific 
speaker note style.



Choosing a speaker note layout
To choose a speaker note layout
1. Click View, Speaker Notes.

You're in Speaker Notes view.
2. Click View, Layout Library.

The Libraries dialog box opens.
3. Click the Layout tab if that page isn't already open.
4. Click the Preset Library button to enable the option.
5. Scroll through the slide thumbnails and choose a speaker note layout.

Use this speaker note layout to create your personal speaker notes.
6. Click OK to apply your choice and close the dialog box.



Creating speaker notes
To create speaker notes
1. Double-click inside a speaker note text box.

You have activated the Paragraph text tool and can type your notes.
2. Type the following speaker notes:

Remember to mention how easy it is to create speaker notes.
3. Fill in the remaining speaker notes with your own text.
Note
Choose one of these methods to move from one speaker note page to another:

Click the speaker notes tab at the bottom of the screen.
Click Edit, Go To, Speaker Note.



Summary
You can incorporate a chart in your presentation to display data in a colorful way. You can apply transition effects 
to objects, as well as slides, and define individual slide properties. In Lesson 4, pull out all the stops and work 
with animation.



Overview
Every object you include in your presentation can be time-based. The timelines feature assists you in managing 
these objects which include transition and sound effects, as well as other multi-media events. Import an 
animation file for even greater impact.
What's in store?

Adding a unique slide background
Animating your presentation
Adding sound
Working with timelines



Adding a unique slide background
You're going to use a different background for the last slide in the presentation. This will leave your audience 
with a lasting impression.
To add a unique slide background
1. Click Insert, Slide.

The Insert Slides Wizard appears.
2. Type 1 in the Number of Slides number box.
3. Check that the After Current button is enabled. If not, click it to enable the option.
4. Click Next.

The Insert Slides - Select A Layout page appears.
5. Click the Preset Library button.
6. Scroll through the slide thumbnails and choose a layout that has text and an OLE object placeholder.
7. Click Next.

The Insert Slides - Select A Background page appears.
8. Click the list box and click Background Group 10.
9. Scroll through the slide thumbnails and click a blue galaxy.

This is the second background style you'll use for this presentation.
10. Click Finish.



Overview
Animation is a series of images which, when played back in sequence, create the illusion of movement. Each of 
these static images is called a frame. We refer to animated images as actors and actors are comprised of cels. A 
cel is a static picture and an actor can have any number of cels.



Activating Animation view
To activate Animation view
1. Move to Slide 6.
2. Click View, Animation.

You're now in Animation view. The VCR toolbar is located at the bottom left of the screen.





Importing an animation
To import an animation into your presentation
1. Click File, Import.

The Import dialog box opens.
2. Click the Look in list box and click the Tutorial folder.
3. Click the Files of type list box, then click Video for Windows (*.AVI).
4. Click an *.AVI file. Its name appears in the File name text box.
5. Click the Preview check box to enable the option.
6. Click the Current Slide button to enable the option.
7. Click Import.

The animation file appears on the presentation page in the animation placeholder in Animation view.
8. Click ( ) to play the animation slide.
Note
An AVI file is actually a video clip, not an animation. The best way to add video clips to a presentation is with the 
Insert, Video command.



Controlling an animation
Use the VCR toolbar in Animation view to control the animation.
You can also slide the animation track bar up or down to move to a different time point in the animation.
The current time indicator beside the VCR toolbar displays the animation's current frame or point in time.





Adding text to the animation slide
Add text to the animation slide using Outline view. Don't forget you can type text directly onto the slide in Slide 
view. Feel free to apply style attributes as you did on the previous slides. See Lesson 2 for some pointers.
To add text to Slide 6
1. Click View, Outline.

Outline view displays.
2. Position the cursor beside Slide 6.
3. Type the following title:

"Presenting Corel PRESENTS!"
4. Type the following bullets:

From charting to animation...
This show deserves an ovation!

Tip
To add a new bullet after the title, press CTRL and ENTER at the same time. Press ENTER to add consecutive 
bullets.



Overview
Sound effects, such as music clips or voice narration, can liven up your presentation and grab the audience's 
attention. In order to add or record a sound, your computer must have the appropriate sound capturing hardware
installed. To add sound, you need a sound card and a set of speakers. To record sound, you also need a 
microphone that is compatible with your sound card.



Adding sound to a slide
You can add a particular sound to an individual slide which only plays when the slide is shown.
To add sound to an individual slide
1. Go to Slide 6, Slide view.
2. Click File, Import.

The Import dialog box opens.
3. Click the Look in list box and click the Media folder.

This is usually located in the Win95 folder.
4. Click the Files of type list box and click Windows Waveform (*.WAV).
5. Click Tada.
6. Click Import.
Note
Click  to play back your sound.



Adding background sound
You can add background sound that plays throughout the entire presentation.
To add background sound to a presentation
1. Click File, Import.

The Import dialog box appears.
2. Click the Look in list box and click the Tutorial folder.
3. Click the Files of type list box and click Windows Waveform (*.WAV).
4. Click a sound file of your choice. Its name appears in the File name text box.
5. Under Import on, click Background 
6. Click Import.
Note
Click File, Run Presentation to play back your background sound.



Recording sound
To record a new sound
1. Click Insert, Sound.

The Wave Editor dialog box opens.

2. Click  to start recording a new sound.

3. Click  to stop recording the sound.
You can zoom in on the sound wave using the Zoom in button.

4. Click  to hear your new sound.
Note
You need a microphone that is compatible with your sound card to record sound. You can save your recorded 
sound. Its default sound quality is 11kHz, 8-bit, mono.



Overview
Sounds are displayed as waveforms in the Wave Editor. A waveform is a graphic representation of a sound. You 
can perform basic editing of the sound, and apply various sound processing effects.



Editing sound
To edit a sound effect waveform
1. Click View, Timelines.

Timelines view appears. You'll work directly with timelines in the following section.
2. Click Slide 6 to highlight it, then double-click to expand this slide.

The slide's list of objects displays.
3. Click the sound object with the right mouse button and click Properties from the pop-up menu.

The Wave Editor dialog box opens.
4. Marqee select a portion of the sound.
5. Click Change Characteristics, Echo.

This action applies an echo effect to the selected portion of sound.
6. Click ( ) to hear the edited sound.
Notes

Most sound-editing operations affect the entire sound if you have not selected a portion of the sound.
You can have a sound play for the duration of the presentation by dragging the slider below the time scale 

in the Timelines dialog and click File, Repeat.



Overview
You display and edit the time relationships between all the elements in your presentation in the Timelines view. 
This feature controls the sequence and timing of events within an individual slide, as well as the timing of all 
slides within a presentation. For example, the instance at which a sound file is played back. Stop the time slider 
to show the position and state of all the objects that would be present at that point in time.



Editing timelines
To edit timelines for your presentation
1. Move to Slide 1, Slide view.
2. Click View, Timelines.

The Timelines dialog box is displayed.
3. Click Slide 1 to highlight it, then double-click to expand the slide.

All objects on the slide are listed.
4. Click the object to which you've applied opening and closing transitions.

You can tell which one it is by its timeline. The object also appears highlighted on the slide.
5. Click and drag the timeline's first boundary up to the 3-second mark on the time scale.

The cursor becomes a two-directional arrow.
6. Click and drag the timeline's second boundary back to the 8-second mark on the time scale.

You've just adjusted the object's transition timeline, as well as the duration of its path.
7. Close the Timelines dialog box.
Note
Object start and finish times may not exceed slide start and finish times.



Using the Timelines dialog box
The Timelines dialog box allows you to change many aspects of the objects within your presentation.



Displaying an object
To display an object during run time and editing modes

Click the check box beside the object identifier so that a check mark appears.



Hiding an object
To hide an object during run time and editing modes

Click the check box beside the object identifier to disable the check mark.



Displaying a slide list
To display a slide list in the Timelines dialog box

Click 

 to collapse the object list.



Naming objects in the Timelines dialog box
To name an object in the Timelines dialog box
1. Click an object in the list to highlight it.
2. Press the left mouse button on the highlighted object, then release.

The word object appears in reverse video and the cursor flashes before the letter o.
3. Type a name for the object.



Deleting an object from the Timelines dialog box
To delete an object from the Timelines dialog box
1. Click an object in the list to highlight it.
2. Press the DELETE key.

The object is removed from the object list, as well as the slide.



Summary
Your presentation is now complete with sound effects and animation. Timelines view allows you to set the 
sequence and timing of events in your slides, and incorporating a unique slide background gives a presentation 
that something extra. It's a wrap in Lesson 5!



Overview
Grab your megaphone and get ready to direct your first screen show!
What's in store?

Using on-screen annotations
Creating a self-running presentation
Creating a portable screen show



Overview
An on-screen annotation is similar to drawing on an overhead with a magic marker. Use this feature when you 
want to emphasize important points to your audience during the presentation.



Setting on-screen annotation pens
To set on-screen annotation pens
1. Click Tools, Options.
2. Click the Presentation tab.
3. Click the Thickness button, then click the pen width you want to use.
4. Click the Color button, then click the pen color you want to use.
5. Click OK.



Using on-screen annotation pens
To use on-screen annotation pens at any time during your presentation
1. Click File, Run Presentation to begin the screen show.
2. When you reach a point in the presentation which you want to emphasize, click and hold down the left mouse 

button to activate the on-screen annotation pen.
3. Use the mouse as the pen to underline or circle an important point.
4. Release the mouse button.
Note
You can edit your slide's timeline so that the screen show pauses as you emphasize an important point with the 
on-screen annotation pen.



Overview
A self-running presentation does just that it runs itself. It automatically advances to each slide and begins again
after displaying the last slide, running in a continuous loop. This feature comes in handy if you want your 
presentation to run continuously at a trade show or exhibit.



Creating a self-running presentation
To create a self-running presentation
1. Click Tools, Options.

The Options dialog box opens.
2. Click the Presentation tab if it's not already displayed.
3. Check that the Automatic Advance to next slide button is enabled.
4. Click the Run continuously button to enable the option.
5. Click OK to apply the changes and close the dialog box.



Playing a self-running presentation
To play a self-running presentation

1. Click  to return to Slide view.
2. Click File, Run Presentation.

The presentation will play over and over until you press the ESC key.



Overview
Say you're going on the road with your presentation and you want to be able to show it to anyone at any time. 
You can create a portable version of your presentation, or screen show, which can be shown on any Windows-
based computer even if Corel PRESENTS is not installed on it.
The Corel PRESENTS Runtime Player (PRESPLR.EXE) is supplied with Corel PRESENTS for distributing and running 
screen shows on computers that do not have Corel PRESENTS installed. You may freely copy and distribute the 
player.
The computer must have Windows 95 installed. If animation files are included in portable screen shows, the 
application in which the animation was created must be installed on the computer that runs the show. If the 
animation program is not installed, the screen show player simply skips the animation slide and moves to the 
next one.



Creating a portable screen show
To create a portable screen show
1. Click File, Save as.

The Save as dialog box opens.
2. Click the Save in list box and open a folder in which to store your portable screen show.
3. Type a name for the screen show in the File name text box.
4. Click the Save as type list box to open it and click Corel PRESENTS Runtime Player.

Corel PRESENTS automatically assigns *.CRP as the file extension for a portable screen show.
5. Click Save.
Note
The Runtime Player option saves a presentation as a non-editable file which can only be run as a screen show. 
Before you save a presentation with this option, make a copy of it or save it under a new name. Without a 
backup copy, you won't be able to open the presentation to make changes.



Playing a portable screen show
There are various methods you can use to play a portable screen show. Choose the one that suits your 
computing environment.

Double-click the PRESPLR.EXE from a Windows 95 file managing utility like File Manager or Windows 
Explorer.

Type PRESPLR.EXE at the Windows 95 DOS prompt and press the ENTER key.
Create a shortcut key to the Corel PRESENTS Runtime Player on your Windows 95 desktop.
Double-click the portable screen show (CPR) file from a Windows 95 file managing utility like File Manager 

or Windows Explorer.



Summary
Bravo and take a bow! You have completed the tutorial and now have the basic skills to begin creating effective 
and interesting presentations. Take some time to experiment with your own ideas. For a complete list of Corel 
PRESENTS procedures, see the online help.
May you always play to a full house and a rapt audience!




